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Overview
Lucidity aims to make the most of your mapmaking experience, and keep others you share
your maps with engaged in the story you want to tell. Whether you want to imagine a luscious
forest surrounding a path to a dragon’s lair atop a mountain or a bustling town of elves found
within the safety of castle walls, Lucidity can help your fantasy become reality.

From the comfort of your home or in a cafe, Lucidity can be used anywhere with access to a
personal Windows or MacOS machine.

An example 2D Lucidity map.

A Lucidity conversion of the example 2D map above.

Next: Installation
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Installation
Downloading and installing Lucidity can be done faster than you can say the word
“imagination”. Visit the Lucidity website at https://www.luciditymap.com/. Once there, you
should notice download links for different operating systems: Windows and MacOS.

Note: an Internet connection is required to download the application.

The Lucidity website, with the Windows and MacOS download buttons in view.

Windows
1. Click theWindows download button.
2. Navigate to your browser download folder.
3. Extract Lucidity-Windows.zip to the desired location.
4. Navigate to the extracted Lucidity-Windows/ folder.
5. Run Lucidity.exe.

Note: Microsoft Defender SmartScreen is enabled on most Windows devices by default. To run
Lucidity.exe, the warning may need to be ignored.

https://www.luciditymap.com/
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Microsoft Defender pop-up on Windows, and how to ignore the warning.

MacOS
1. Click the MacOS download button.
2. Navigate to your browser download folder.
3. Extract Lucidity-Mac.zip to the desired location.
4. Navigate to the extracted Lucidity-Mac/ folder.
5. Run Lucidity.

Next: Loading In…
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Loading In…
Now that you’ve opened Lucidity, you’re one step closer to either envisioning your own
imagination, or seeing someone else's creation. On loading in, you’ll be met with two options:
"Create new map" or "Load existing map."

The Lucidity home screen.

Create New Map
You can start with creating a new map. Whether you are a frequent mapmaker, or just exploring
Lucidity, it’s great to start with the basics.

1. On the Lucidity main screen, click Create new map.
2. In the Name text box, enter the desired (file) name of the map.
3. In the Biome dropdown, select the desired biome of the map.
4. When finished, click Create!.
5. In the file dialog menu, select the directory for the map file to be saved, and click

Select. To return to the previous screen to make edits, click Cancel.
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The Lucidity map creation screen.

Load Existing Map
If you thought creating a map was simple, loading a map is even simpler, and can be done in
two simple steps.

1. On the Lucidity main screen, click Load existing map.
2. In the dialog file menu, select the desired JSON (.json) file corresponding to a valid

Lucidity map, and click Select. To return to the previous screen, click Cancel.

Note: if an invalid JSON file is loaded, a new map will be created. Importantly, this new map
will have the selected file path, and may overwrite data in that file.
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The Lucidity file dialog menu.

Next: Map Editor
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Map Editor
The map editor, or simply editor, is the primary component of Lucidity that allows anyone to
create a map from their imagination. It allows creators to place and modify different built-in
structures like trees and houses. The editor itself is designed to be simple, and takes
inspiration from other applications for those sweet, transferable skills.

A newly created Lucidity map in the editor.

File Menu
The file menu can be found at the top-left of the editor screen, and is going to be home to
some useful functions. The file menu can be opened by clicking File, which will bring up a
menu with four options:
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The expanded editor file menu.

New File

Probably the case if you’ve messed up a map beyond repair and need to start fresh, or just
want to pop open a fresh map without restarting Lucidity. From within a map, a new map can
be created. Clicking New File will prompt you to save or discard the current map. Clicking Yes
will save any changes made to the map, whereas clicking No will discard any changes made to
the map. Either option will redirect you to the Create New Map step. Clicking Cancel will
instead close the prompt and return to the current map.

Open File

If maybe you’ve loaded up the wrong map, fear not! From within a map, a pre-existing map can
be opened. Clicking Open File will prompt you to save or discard the current map. Clicking
Yes will save any changes made to the map, whereas clicking No will discard any changes
made to the map. Either option will redirect you to the Create New Map step. Clicking Cancel
will instead close the prompt and return to the current map.
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The save prompt when either creating or opening a map from the editor.

Save

Maybe you’re preparing to send out your new map. Maybe you’re worried your computer will
crash suddenly. Maybe you’re too used to losing hours of work in an instant. Whatever the
reason, you will probably want to save your map. Clicking Save will save any changes recently
made to the map, at the previously specified file location. A successful save is indicated at the
top-right of the screen with the text Saved!.

Save As…

If you want to save your map into a new file, you can do so using this feature. Clicking Save
As… will prompt you with a new file dialog menu (like the one seen in Create New Map. A new
file location can be specified to save the new revision, keeping any older, outdated but possibly
useful copies of the map.

Painting
The next step after creating a map is being able to place the various structures offered in
Lucidity to recreate the constructs of your creativity. Indicated by a paintbrush symbol, the
Painting tool must be selected in the left-most toolbar to enter Painting mode.
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The Painting menu found on the left side when in Painting mode.

Sprites

There are several structures offered in Lucidity (with more to come!). Each of these structures
come in a package with both a 2D sprite, and a 3D asset. Freely use any of the 2D sprites in
the editor, and its position, size, and orientation will be reflected in a 3D conversion of your
Lucidity map!

Fortress sprite and asset. House sprite and asset.
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Mountain sprite and asset. Tree sprite and asset.

All available sprites can be found in the Painting menu, under the Sprites tab. A sprite can be
selected by clicking the button corresponding to the desired sprite, changing your current
sprite to the one chosen.

Brush

In the editor with any of the sprites selected, your cursor will now become a brush. You should
see an image of the sprite wherever your cursor is to show where the sprite would be placed.
The brush can be clicked or even dragged to place assets, either at the point you clicked or
along the path you dragged across.
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Example: selected fortress sprite is reflected in the brush.

When attempting to place sprites, it is possible that you may run into issues. How do you think
a tree could be placed in the same place as a house? Oh right, it can’t. Invalid placements will
be indicated by showing both the placed sprite and the attempted placement as red.

Example: an invalid placement of a tree on a house.

Options

Making maps can be a little tedious sometimes. It could be because of precise placement.
Maybe you’ve got to place hundreds, maybe thousands of sprites on the map. There are some
options that can be applied to the brush to make your life just a little bit easier. All of these
options can be found in the Painting menu, under the Options tab.

Count

The Count input box allows you to change how many assets would be placed at a time.
Combined with the ability to drag the brush, you can place plenty of identical structures in a
short amount of time.
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Example: a brush with a count of 4.

Asset Spread

The Asset Spread slider allows you to change the amount of space between assets placed,
represented as a multiplier of the sprite’s size. This will increase the size of the brush, while also
maximizing the space between all the sprites in your brush. If you wanted to make a dense
forest, or one with enough walking room, you can do it all using this option.

Example: a brush with a count of 4 and a spread of 1.5x.
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Random Placement

The Random Placement toggle is used for those cases where you want to reduce the
randomness of all those sprites you will be placing. With the toggle on, your brush places
sprites in a consistent top-to-bottom, left-to-right approach. On the other hand, with the toggle
off, your brush places sprites in a random arrangement, only making sure to place the correct
number.

Example: a brush with a count of 5 and random placement disabled.

Example: a brush with a count of 5 and random placement enabled.

Tools
Besides painting, there are plenty of other tools that you can use in the editor, also accessible
in the left-most toolbar. You’ve probably seen similar tools in a number of other software, but a
summary of them is as follows:

The Selection tool. The Panning tool.
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The Painting tool. The Zoom tools.

The Undo/Redo tools.

Selection

Sometimes you may not like the look of a sprite after you place it down. Clicking the Selection
button indicated by the cursor, you will enter Selection mode, and bring up the Selection. While
in Selection mode, it becomes possible to select any placed sprite and modify it in several
ways, namely by scale, rotation, and its existence.

The Selection menu found on the left side when in Selection mode.

Scale

The Scale slider allows you to change the size of a selected sprite placed on the map, to make
that house the perfect size for a dwarf or a mountain the size of Everest.
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Example: increasing the scale of a fortress sprite to 2.5x.

Rotation

The Rotation buttons allow you to rotate a selected sprite placed on the map, both clockwise
and counterclockwise by 45 degrees.

Example: rotating a mountain sprite 90 degrees clockwise.

Delete

This feature should be fairly self-explanatory. With a selected object, the Delete button allows
you to remove the sprite from the map.
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Pan

Building large, expansive maps sometimes means that what you can see on your screen just
isn’t enough. Clicking the Pan button indicated by a hand puts you into Panning mode. Here,
clicking and dragging your mouse allows you to pull the camera around the large map. If you
thought you ran out of space to keep making your map, you probably didn’t.

Zoom

Being an architect can be tough, and one such reason can be due to needing to be precise.
Sometimes, you may require zooming in and out. Clicking either Zoom button indicated by
magnifying glasses puts you into Zoom mode. Using the Zoom In button, each mouse click will
consequently zoom you closer into the map. Using the Zoom Out button, each mouse click
will consequently zoom you farther from the map. These can be useful for when you need to
get those precise sprite placements.

Undo/Redo

Everyone makes mistakes. Many also make mistakes about these mistakes. The Undo and
Redo buttons function as you may find in virtually any other application. Any action taken in
Lucidity can be undone if it was done incorrectly. If you happen to realize it was indeed correct,
the actions can also be redone.

Layers
Staying organized when making anything complex is always crucial. Layers help you to stay
organized, being able to group the sprites you place. Moreover, this can also provide different
functionality, like stacking certain sprites. The Layer menu can be found on the right side of the
editor. The currently selected layer is highlighted, indicating to you which layer new sprites will
be placed on.
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The Layer menu found on the right side.

Using layers introduces a hierarchy that can be used to stack certain sprites. Currently, trees
are able to be placed on top of mountains on a lower layer. This is just one of the few
possibilities of Lucidity to make your maps reach that next level.

Example: tree sprite placed on top of a mountain sprite by using layers.

Example: 3D-ify a tree sprite on top of a mountain sprite.

Add Layer

To add a new layer onto what already exists, click the Add Layer button at the top right of the
Layers menu. This will append a new layer to the list (building downwards in the list of layers).
Its name will also indicate the number of the layer.
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Visibility

The massive forest you made in the background a little too distracting? On each layer is a
clickable Visibility button indicated by an eye. The visibility of each layer can be toggled on or
off, either showing or hiding the sprites from your view.

Rename

If you’re already using layers to organize your map, you should probably also give your layers
appropriate names. Each layer can be renamed by clicking the Rename button indicated by a
pencil. Feel free to rename your layers to indicate what you have on it, or feel free to leave it as
it is.

Delete

The Delete button indicated by a trash can can be found in most applications, and has a
universal purpose. Use this tool to completely remove a layer, deleting each of its sprites in the
process.

Next: 3D-ify
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3D-ify
With your finalized map, you are now ready to convert it to a more comprehensive 3D version.
This can be done by clicking the 3D-ify! button at the bottom of the Layer menu. In doing so,
you will be transported into the 3D world, and able to navigate around a replica of the 2D map.

Example: a map converted into 3D.

Controls
While in this 3D realm, you can look around by moving your mouse and you can move around
with the following control scheme:

W - forward
A - left
S - backward
D - right

Walk around the generated world and interact with the different structures. Real physics will be
applied, and you won’t be able to do anything like walk through walls, unless you…

Noclip

With the Noclip option on, you will be able to defy all notions of physics. Continuing from
before, you will be able to clip freely through any and all structures on the map. Importantly,
you also gain the ability of flight! This introduces two new controls:

SPACE - ascend
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[LEFT/RIGHT] SHIFT - descend
Whether you want to pretend you’re on the highest peak, or just get a birds-eye view, using the
Noclip feature may prove to be very useful in describing your narrative.

Options
While in the 3D world, you may find that it may not feel to your liking. Maybe you’re used to
first-person video games and like a different sensitivity. Maybe you want to fly around freely
rather than be restricted to the ground. There are several options that can be tweaked to your
liking.

The Options menu found on the bottom-right.

Movement Speed

The Movement Speed slider allows you to either continue moving at a normal speed, or zoom
across the map. If you feel that walking around in the 3D world is too slow, bump up the speed
a little bit and you’ll see change in a flash.

Sensitivity

The Sensitivity slider will help you feel less sluggish when moving your mouse or trackpad
around the screen. Tweak it as you see fit, making sure you can fully immerse yourself in the 3D
experience.
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Noclip

As mentioned in the Controls, the Noclip toggle will allow you to move freely through the map,
ignoring physics like gravity and colliding with objects. Use this to gain more freedom during
3D exploration.

Back to Editor

Clicking the Back to Editor button will return you to the editor, with all of your progress
retained. Continue to make edits to your map, 3D-ifying until Lucidity satisfies your imagination!


